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CHAPTER 1

Video course

Those who prefer a didactically structured video course over this documentation should have a look at our
video course:

https://training.xlwings.org/p/xIwings

It’s also a great way to support the ongoing development of xlwings :)



https://training.xlwings.org/p/xlwings
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CHAPTER 2

Installation

2.1 Prerequisites

* xlwings requires an installation of Excel and therefore only works on Windows and macQOS. Note
that macOS currently does not support UDFs.

* xlwings requires at least Python 3.6.
Here are the last versions of xlwings to support:

* Python 3.5: 0.19.5

e Python 2.7: 0.16.6

2.2 Installation

xlwings comes pre-installed with
* Anaconda (Windows and macOS)
* WinPython (Windows only) Make sure not to take the dot version as this only contains Python.

If you are new to Python or have trouble installing xIwings, one of these distributions is highly recom-
mended. Otherwise, you can also install it manually with pip:

pip install xlwings

or conda:

conda install xlwings



https://www.anaconda.com/products/individual
https://winpython.github.io
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Note that the official conda package might be a few releases behind. You can, however, use the
conda-forge channel (replace install with upgrade if xlwings is already installed):

conda install -c¢ conda-forge xlwings

Note: When you are on macOS and are installing xIwings with conda (or use the version that comes with
Anaconda), you’ll need to run $ xlwings runpython install once to enable the RunPython
calls from VBA. This is done automatically if you install the addin via $ x1lwings addin install.

2.3 Add-in

To install the add-in, run the following command:

xlwings addin install

To call Excel from Python, you don’t need an add-in. Also, you can use a single file VBA module (stan-
dalone workbook) instead of the add-in. For more details, see Add-in & Settings.

Note: The add-in needs to be the same version as the Python package. Make sure to re-install the add-in
after upgrading the xlwings package.

2.4 Dependencies

e Windows: pywin32
* Mac: psutil, appscript

The dependencies are automatically installed via conda or pip.

2.5 How to activate xlwings PRO

xlwings PRO offers access to additional functionality. All PRO features are marked with xlwings PRO in
the docs.

Note: To get access to the additional functionality of xlwings PRO, you need a license key and at least xI-
wings v0.19.0. Everything under the x1wings . pro subpackage is distributed under a commercial license.
See xlwings PRO Overview for more details.

To activate the license key, run the following command:

4 Chapter 2. Installation




xlwings - Make Excel Fly!, Release dev

xlwings license update -k LICENSE_KEY

Make sure to replace LICENSE_KEY with your personal key. This will store the license key under your
x1lwings.conf file (see User Config: Ribbon/Config File for where this is on your system). Alternatively,
you can also store the license key as an environment variable with the name XLWINGS_LICENSE_KEY.

xlwings PRO requires additionally the cryptography and Jinja2 packages which come preinstalled
with Anaconda and WinPython. Otherwise, install them via pip or conda.

With pip, you can also run pip install "xlwings[pro]" which will take care of the extra depen-
dencies for xIlwings PRO.

2.6 Optional Dependencies

* NumPy

* Pandas

* Matplotlib

* Pillow/PIL

 Flask (for REST API)

* cryptography (for xlwings.pro)
* Jinja2 (for xlwings.pro.reports)
* requests (for permissioning)

These packages are not required but highly recommended as they play very nicely with xlwings. They are
all pre-installed with Anaconda. With pip, you can install xIwings with all optional dependencies as follows:

pip install "xlwings[all]"

2.7 Update

To update to the latest xlwings version, run the following in a command prompt:

pip install --upgrade xlwings

or:

conda update -c conda-forge xlwings

Make sure to keep your version of the Excel add-in in sync with your Python package by running the
following (make sure to close Excel first):

xlwings addin install

2.6. Optional Dependencies 5
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2.8 Uninstall

To uninstall xlwings completely, first uninstall the add-in, then uninstall the xIwings package using the same
method (pip or conda) that you used for installing it:

xlwings addin remove

Then

pip uninstall xlwings

or:

conda remove xlwings

Finally, manually remove the

.x1wings directory in your home folder if it exists.

Chapter 2. Installation




CHAPTER 3

Quickstart

This guide assumes you have xlwings already installed. If that’s not the case, head over to Installation.

3.1 1. Interacting with Excel from a Jupyter notebook

If you’re just interested in getting a pandas DataFrame in and out of your Jupyter notebook, you can use the
view and load functions, see Jupyter Notebooks: Interact with Excel.

3.2 2. Scripting: Automate/interact with Excel from Python

Establish a connection to a workbook:

>>> import xlwings as xw

>>> wb = xXw.Book () # this will create a new workbook

>>> wb = xw.Book ('FileName.xlsx') # connect to a file that is open or in the_
—current working directory

>>> wb = xw.Book (r'C:\path\to\file.xlsx'"') # on Windows: use raw strings to,

—escape backslashes

If you have the same file open in two instances of Excel, you need to fully qualify it and include the app
instance. You will find your app instance key (the PID) via xw. apps.keys ():

>>> xw.apps[10559] .books['FileName.xlsx"]

Instantiate a sheet object:

>>> sheet = wb.sheets['Sheetl']
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Reading/writing values to/from ranges is as easy as:

>>> sheet.range('Al'") .value = 'Foo 1°'
>>> sheet.range ('Al'") .value
'Foo 1"

There are many convenience features available, e.g. Range expanding:

>>> sheet.range('Al') .value = [['Foo 1', 'Foo 2', 'Foo 3'], [10.0, 20.0, 30.
—01]
>>> sheet.range('Al") .expand() .value

[['Foo 1', 'Foo 2', 'Foo 3'], [10.0, 20.0, 30.01]

Powerful converters handle most data types of interest, including Numpy arrays and Pandas DataFrames
in both directions:

>>> import pandas as pd

>>> df = pd.DataFrame([[1,2], [3,4]], columns=['a', 'b'])

>>> sheet.range('Al') .value = df

>>> sheet.range ('Al'") .options (pd.DataFrame, expand='table') .value
a b

0.0 1.0 2.0

1.0 3.0 4.0

Matplotlib figures can be shown as pictures in Excel:

>>> import matplotlib.pyplot as plt

>>> fig = plt.figure()

>>> plt.plot ([1, 2, 3, 4, 5])

[<matplotlib.lines.Line2D at 0x1071706a0>]

>>> sheet.pictures.add(fig, name='MyPlot', update=True)
<Picture 'MyPlot' in <Sheet [Workbook4]Sheetl>>

3.3 3. Macros: Call Python from Excel

You can call Python functions either by clicking the Run button (new in v0.16) in the add-in or from VBA
using the RunPython function:

The Run button expects a function called main in a Python module with the same name as your workbook.
The great thing about that approach is that you don’t need your workbooks to be macro-enabled, you can
save it as x1sx.

If you want to call any Python function no matter in what module it lives or what name it has, use
RunPython

Sub HelloWorld()
RunPython "import hello; hello.world()"
End Sub

Note: Per default, RunPython expects hello.py in the same directory as the Excel file with the same

8 Chapter 3. Quickstart
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name, but you can change both of these things: if your Python file is an a different folder, add that folder
to the PYTHONPATH in the config. If the file has a different name, change the RunPython command
accordingly.

Refer to the calling Excel book by using xw.Book.caller ():

# hello.py
import numpy as np
import xlwings as xw

def world():
wb = xw.Book.caller ()
wb.sheets[0] .range ('Al") .value = 'Hello World!'

To make this run, you’ll need to have the xlwings add-in installed or have the workbooks setup in the
standalone mode. The easiest way to get everything set up is to use the xlwings command line client from
either a command prompt on Windows or a terminal on Mac: x1wings quickstart myproject.

For details about the addin, see Add-in & Settings.

3.4 4. UDFs: User Defined Functions (Windows only)

Writing a UDF in Python is as easy as:

import xlwings as xw

@xw. func
def hello (name) :
return f'Hello {name/'

Converters can be used with UDFs, too. Again a Pandas DataFrame example:

import xlwings as xw
import pandas as pd

@xw. func
@xw.arg('x', pd.DataFrame)
def correl2(x):
# x arrives as DataFrame
return x.corr ()

Import this function into Excel by clicking the import button of the xlwings add-in: for a step-by-step
tutorial, see User Defined Functions (UDFs).

3.4. 4. UDFs: User Defined Functions (Windows only) 9
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CHAPTER 4

Connect to a Book

When reading/writing data to the active sheet, you don’t need a book object:

>>> import xlwings as xw
>>> xw.Range ('Al') .value = 'something'

4.1 Python to Excel

The easiest way to connect to a book is offered by xw.Book: it looks for the book in all app instances and
returns an error, should the same book be open in multiple instances. To connect to a book in the active app
instance, use xw .books and to refer to a specific app, use:

>>> app = xw.App () # or something like xw.apps[10559] for existing apps, get,
—the available PIDs via xw.apps.keys()
>>> app.books|['Bookl']

Note that you usually should use App as a context manager as this will make sure that the Excel instance is
closed and cleaned up again properly:

with xw.App () as app:
book = app.books['Bookl"]

xw.Book xw.books
New book xw.Book () xw.books.add ()
Unsaved book Xw.Book ('Bookl") Xw.books [ 'Bookl"']
Book by | xw.Book (r'C:/path/to/ xw.books.open (r'C:/path/to/
(full)name file.xlsx") file.xlsx"')

11
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Note: When specifying file paths on Windows, you should either use raw strings by putting an r in front
of the string or use double back-slashes like so: C:\\path\\to\\file.x1lsx.

4.2 Excel to Python (RunPython)

To reference the calling book when using RunPython in VBA, use xw.Book.caller (), see Call
Python with “RunPython”. Check out the section about Debugging to see how you can call a script from
both sides, Python and Excel, without the need to constantly change between xw.Book.caller () and
one of the methods explained above.

4.3 User Defined Functions (UDFs)

Unlike RunPython, UDFs don’t need a call to xw.Book.caller (), see User Defined Functions
(UDFs). You’ll usually use the caller argument which returns the xIwings range object from where
you call the function.

12 Chapter 4. Connect to a Book



CHAPTER B

Syntax Overview

The xIwings object model is very similar to the one used by VBA.

All code samples below depend on the following import:

>>> import xlwings as xw

5.1 Active Objects

# Active app (i.e. Excel instance)
>>> app = Xw.apps.active

# Active book
>>> wb = xw.books.active # in active app
>>> wb = app.books.active # in specific app

# Active sheet
>>> sheet = xw.sheets.active # in active book

>>> sheet = wb.sheets.active # in specific book

# Range on active sheet

>>> xw.Range ('Al") # on active sheet of active book of active app

A Range can be instantiated with A1 notation, a tuple of Excel’s 1-based indices, a named range or two

Range objects:

xw.Range ('Al")
xw.Range ('A1:C3")
xw.Range ((1,1))

(continues on next page)

13
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(continued from previous page)

xw.Range ((1,1), (3,3))
xw.Range ('NamedRange ")
xw.Range (xw.Range ('A1'"), xw.Range('B2'))

5.2 Full qualification

Round brackets follow Excel’s behavior (i.e. 1-based indexing), while square brackets use Python’s O-based
indexing/slicing. As an example, the following expressions all reference the same range:

xw.apps[763] .books[0] .sheets[0] .range ('Al")

xw.apps (10559) .books (1) .sheets (1) .range('Al")
xw.apps[763] .books['Bookl'].sheets['Sheetl'].range ('Al")
xw.apps (10559) .books ('Bookl ") .sheets ('Sheetl') .range ('Al")

Note that the apps keys are different for you as they are the process IDs (PID). You can get the list of your
PIDs via xw.apps.keys ().

5.3 App context manager

If you want to open a new Excel instance via App (), you usually should use App as a context manager as
this will make sure that the Excel instance is closed and cleaned up again properly:

with xw.App () as app:
book = app.books['Bookl"]

5.4 Range indexing/slicing

Range objects support indexing and slicing, a few examples:

>>> rng = xw.Book () .sheets[0].range('A1:D5")
>>> rng[0, 0]

<Range [Workbookl]Sheetl!SAS1>

>>> rng[1l]

<Range [Workbookl]Sheetl!$BS1>
>>> rngl[:, 3:]

<Range [Workbookl]Sheetl!$D$1:$D$5>
>>> rng[l 1:3]

[

<Range Workbookl]Sheetl!$B$2:$C$3>

5.5 Range Shortcuts

Sheet objects offer a shortcut for range objects by using index/slice notation on the sheet object. This evalu-
ates to either sheet . range or sheet.cells depending on whether you pass a string or indices/slices:

14 Chapter 5. Syntax Overview
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>>> sheet = xw.Book () .sheets['Sheetl']
>>> sheet ['Al']

<Range [Bookl]Sheetl!S$SAS$1>

>>> sheet ['Al1:B5'"]

<Range [Bookl]Sheetl!SAS1:$BS$S5>

>>> sheet [0, 1]

<Range [Bookl]Sheetl!S$BS1>

>>> sheet[:10, :10]

<Range [Bookl]Sheetl!S$AS$1:5J$10>

5.6 Object Hierarchy

The following shows an example of the object hierarchy, i.e. how to get from an app to a range object and
all the way back:

>>> rng = xw.apps[10559] .books[0] .sheets[0] .range('Al")
>>> rng.sheet .book.app
<Excel App 10559>

5.6. Object Hierarchy 15
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CHAPTER O

Data Structures Tutorial

This tutorial gives you a quick introduction to the most common use cases and default behaviour of xIwings
when reading and writing values. For an in-depth documentation of how to control the behavior using the
options method, have a look at Converters and Options.

All code samples below depend on the following import:

>>> import xlwings as xw

6.1 Single Cells

Single cells are by default returned either as f1oat, unicode, None or datetime objects, depending
on whether the cell contains a number, a string, is empty or represents a date:

>>> import datetime as dt

>>> sheet = xw.Book () .sheets[0]

>>> sheet.range('Al'") .value = 1

>>> sheet.range ('Al'") .value

1.0

>>> sheet.range('A2') .value = 'Hello'
>>> sheet.range('A2") .value

'Hello'

>>> sheet.range ('A3'") .value is None
True

>>> sheet.range('A4') .value = dt.datetime (2000, 1, 1)
>>> sheet.range ('A4") .value

datetime.datetime (2000, 1, 1, 0, 0)

17
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6.2 Lists

* 1d lists: Ranges that represent rows or columns in Excel are returned as simple lists, which means
that once they are in Python, you’ve lost the information about the orientation. If that is an issue, the
next point shows you how to preserve this info:

>>> sheet = xw.Book () .sheets[0]

>>> sheet.range('Al').value = [[1]1,1[2]1,1[31,104]1,15]1] # Column,_,
—orientation (nested 1ist)

>>> sheet.range ('Al:A5") .value

[1.0, 2.0, 3.0, 4.0, 5.0]

>>> sheet.range('Al'") .value = [1, 2, 3, 4, 5]

>>> sheet.range('Al:E1l") .value

[1.0, 2.0, 3.0, 4.0, 5.0]

To force a single cell to arrive as list, use:

>>> sheet.range('Al") .options (ndim=1) .value
[1.0]

Note: To write a list in column orientation to Excel, use transpose: sheet.range ('A1'") .
options (transpose=True) .value = [1,2,3,4]

* 2d lists: If the row or column orientation has to be preserved, set ndim in the Range options. This
will return the Ranges as nested lists (“2d lists™):

>>> sheet.range ('A1:A5") .options (ndim=2) .value
[[1.0], [2.0], [3.0], [4.0], [5.0]]
>>> sheet.range('A1l:E1") .options (ndim=2) .value

[(1.0, 2.0, 3.0, 4.0, 5.0]]

» 2 dimensional Ranges are automatically returned as nested lists. When assigning (nested) lists to a
Range in Excel, it’s enough to just specify the top left cell as target address. This sample also makes
use of index notation to read the values back into Python:

>>> sheet.range('A10') .value = [['Foo 1', 'Foo 2', 'Foo 3'], [10, 20,
3011

>>> sheet.range ((10,1), (11,3)) .value

[['Foo 1', 'Foo 2', 'Foo 3'], [10.0, 20.0, 30.01]

Note: Try to minimize the number of interactions with Excel. It is always more efficient to do sheet.
range ('Al') .value = [[1,2],[3,4]] than sheet.range('Al"') .value = [1, 2] and
sheet.range ('A2'") .value = [3, 4].
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6.3 Range expanding

You can get the dimensions of Excel Ranges dynamically through either the method expand or through the
expand keyword in the opt ions method. While expand gives back an expanded Range object, options
are only evaluated when accessing the values of a Range. The difference is best explained with an example:

>>> sheet = xw.Book () .sheets[0]

>>> sheet.range ('Al'") .value = [[1,2], [3,4]1]

>>> rngl = sheet.range('Al'") .expand('table') # or just .expand/()
>>> rng2 = sheet.range('Al') .options (expand='table')

>>> rngl.value

[[1.0, 2.0], [3.0, 4.011

>>> rng2.value

[(1.0, 2.01, 3.0, 4.071]

>>> sheet.range ('A3") .value = [5, 6]
>>> rngl.value

[[1.0, 2.0], [3.0, 4.011

>>> rng2.value

(fr.o0, 2.01, 13.0, 4.01, [5.0, 6.011

'table' expandsto 'down' and 'right ', the other available options which can be used for column or
row only expansion, respectively.

Note: Using expand () together with a named Range as top left cell gives you a flexible setup in Excel:
You can move around the table and change its size without having to adjust your code, e.g. by using
something like sheet . range ('NamedRange') .expand () .value.

6.4 NumPy arrays

NumPy arrays work similar to nested lists. However, empty cells are represented by nan instead of None.
If you want to read in a Range as array, set convert=np.array in the opt ions method:

>>> import numpy as np

>>> sheet = xw.Book () .sheets[0]
>>> sheet.range ('Al'") .value = np.eye (3)
>>> sheet.range('Al'") .options (np.array, expand='table') .value
array ([[ 1., 0., 0.1,
[ 0., 1., 0.1,
[ 0., 0., 1.11)

6.5 Pandas DataFrames

>>> sheet = xw.Book () .sheets[0]
>>> df = pd.DataFrame([[1.1, 2.2], [3.3, None]], columns=['one', 'two'l])
>>> df

(continues on next page)
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(continued from previous page)

one two

0 1.1 2.2

1 3.3 NaN

>>> sheet.range('Al'") .value = df

>>> sheet.range ('A1:C3") .options (pd.DataFrame) .value
one two

0 1.1 2.2

1 3.3 NaN

# options: work for reading and writing

>>> sheet.range('A5') .options (index=False) .value = df

>>> sheet.range ('A9') .options (index=False, header=False) .value = df

6.6 Pandas Series

>>> import pandas as pd
>>> import numpy as np

>>> sheet = xw.Book () .sheets[0]

>>> s = pd.Series([1.1, 3.3, 5., np.nan, 6., 8.], name='myseries')
>>> s

0 1.1

1 3.3

2 5.0

3 NaN

4 6.0

5 8.0

Name: myseries, dtype: floaté64

>>> sheet.range('Al'") .value = s

>>> sheet.range ('A1:B7") .options (pd.Series) .value
0 1.1

1 3.3

2 5.0

3 NaN

4 6.0

5 8.0

Name: myseries, dtype: floaté4

Note: You only need to specify the top left cell when writing a list, a NumPy array or a Pandas DataFrame
to Excel, e.g.: sheet.range ('Al') .value = np.eye (10)

6.7 Chunking: Read/Write big DataFrames etc.

When you read and write from or to big ranges, you may have to chunk them or you will hit a timeout or a
memory error. The ideal chunksize will depend on your system and size of the array, so you will have to
try out a few different chunksizes to find one that works well:
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import pandas as pd

import numpy as np

sheet = xw.Book () .sheets[0]

data = np.arange(75_000 * 20).reshape(75_000, 20)
df = pd.DataFrame (data=data)

sheet ['A1'"'] .options (chunksize=10_000) .value = df

And the same for reading:

# As DataFrame

df = sheet['Al'].expand() .options (pd.DataFrame, chunksize=10_000) .value
# As list of 1list

df = sheet['Al'].expand() .options (chunksize=10_000) .value
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Add-in & Settings

File Home Insert Page Layout Formulas Data Review View Developer Help xlwings
D Interpreter: Conda Path: 'ﬁc UDF Modules: RunPython: Use UDF Server
PYTHONPATH: Conda Env: Debug UDFs Show Console
n Import
main Functions ¥ Restart UDF Server Version: dev
Python Conda User Defined Functions (UDFs) Advanced

The xIwings add-in is the preferred way to be able to use the Run main button, RunPython or UDF's.
Note that you don’t need an add-in if you just want to manipulate Excel by running a Python script.

Note: The ribbon of the add-in is compatible with Excel >= 2007 on Windows and >= 2016 on Mac. On
Mac, all UDF related functionality is not available.

Note: The add-in is password protected with the password x1wings. For debugging or to add new
extensions, you need to unprotect it. Alternatively, you can also install the add-in via x1wings addin
install —--unprotected.

7.1 Run main

New in version 0.16.0.

The Run main button is the easiest way to run your Python code: It runs a function called main in a
Python module that has the same name as your workbook. This allows you to save your workbook as
x1sx without enabling macros. The x1wings quickstart command will create a workbook that will
automatically work with the Run button.
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7.2 Installation

To install the add-in, use the command line client:

xlwings addin install

Technically, this copies the add-in from Python’s installation directory to Excel’s XLSTART folder. Then,
to use RunPython or UDF's in a workbook, you need to set a reference to x1wings in the VBA editor,
see screenshot (Windows: Tools > References..., Mac: it’s on the lower left corner of the VBA
editor). Note that when you create a workbook via x1wings quickstart, the reference should already
be set.

References - VBAProject X
Available References: OK
v Visual Basic For Applications A Cancel

v Microsoft Excel 16.0 Object Library

v|OLE Automation

¥ Microsoft Office 16.0 Object Library Browse...
Microsoft Forms 2.0 Object Library

Ref Edit Control j

Solver

v Priority
AccessibilityCplAdmin 1.0 Type Library Help
Acrobat Access 3.0 Type Library j
AcroBrokerLib

Active DS Type Library
ActiveMovie control type library
AdHocReportinaExcelClientLib

7.3 User Settings

When you install the add-in for the first time, it will get auto-configured and therefore, a quickstart
project should work out of the box. For fine-tuning, here are the available settings:

* Interpreter: This is the path to the Python interpreter. This works also with virtual or conda
envs on Mac. If you use conda envs on Windows, then leave this empty and use Conda Path
and Conda Env below instead. Examples: "C:\Python39\pythonw.exe" or "/usr/
local/bin/python3.9". Note that in the settings, this is stored as Interpreter_Win or
Interpreter_Mac, respectively, see below!

* PYTHONPATH: If the source file of your code is not found, add the path to its directory here.

* Conda Path: If you are on Windows and use Anaconda or Miniconda, then type here the path to
your installation, e.g. C: \Users\Username\Miniconda3 or $USERPROFILE%\Anaconda.
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NOTE that you need at least conda 4.6! You also need to set Conda Env, see next point.

* Conda Env: If you are on Windows and use Anaconda or Miniconda, type here the name of your
conda env, e.g. base for the base installation or myenv for a conda env with the name myenv.

* UDF Modules: Names of Python modules (without .py extension) from which the UDFs are be-
ing imported. Separate multiple modules by “;”. Example: UDF_MODULES = "common_udfs;
myproject" The default imports a file in the same directory as the Excel spreadsheet with the same
name but ending in . py.

* Debug UDFs: Check this box if you want to run the xIwings COM server manually for debugging,
see Debugging.

* RunPython: Use UDF Server: Usesthe same COM Server for RunPython as for UDFs. This
will be faster, as the interpreter doesn’t shut down after each call.

* Restart UDF Server: This restarts the UDF Server/Python interpreter.

* Show Console: Check the box in the ribbon or set the config to TRUE if you want the command
prompt to pop up. This currently only works on Windows.

7.3.1 Anaconda/Miniconda

If you use Anaconda or Miniconda on Windows, you will need to set your Conda Path and Conda Env
settings, as you will otherwise get errors when using NumPy etc. In return, leave Interpreter empty.

7.4 Environment Variables

With environment variables, you can set dynamic paths e.g. to your interpreter or PYTHONPATH:
* On Windows, you can use all environment variables like so: $USERPROFILE%\Anaconda.

* On macOS, the following special variables are supported: SHOME, SAPPLICATIONS,
SDOCUMENTS, SDESKTOP.

7.5 User Config: Ribbon/Config File

The settings in the xIwings Ribbon are stored in a config file that can also be manipulated externally. The
location is

* Windows: .xlwings\xlwings.conf in your home folder, that is usually
C:\Users\<username>

* macOS: ~/Library/Containers/com.microsoft.Excel/Data/xlwings.conf

The format is as follows (currently the keys are required to be all caps) - note the OS specific Interpreter
settings!
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"INTERPRETER_WIN", "C:\path\to\python.exe"
"INTERPRETER_MAC", "/path/to/python”
"PYTHONPATH",""

"CONDA PATH",""

"CONDA ENV",""

"UDF MODULES",""

"DEBUG UDFS",""

"USE UDF SERVER",""

"SHOW CONSOLE",""

"ONEDRIVE_WIN",""

"ONEDRIVE_MAC",""

Note: The ONEDRIVE_WIN/_MAC setting has to be edited directly in the file, there is currently no
possibility to edit it via the ribbon. Usually, it is only required if you are either on macOS or if your
environment variables on Windows are not correctly set or if you have a private and corporate location and
don’t want to go with the default one. ONEDRIVE_WIN/_MAC has to point to the root folder of your local
OneDrive folder.

7.6 Workbook Directory Config: Config file

The global settings of the Ribbon/Config file can be overridden for one or more workbooks by creating a
x1lwings.conf file in the workbook’s directory.

7.7 Workbook Config: xlwings.conf Sheet

Workbook specific settings will override global (Ribbon) and workbook directory config files: Workbook
specific settings are set by listing the config key/value pairs in a sheet with the name x1wings.conf.
When you create a new project with xlwings quickstart, it’ll already have such a sheet but you need
to rename it to xlwings.conf to make it active.

A B
1 |Interpreter pythonw
2 PYTHONPATH
3 UDF Modules
4 Debug UDFs FALSE
5 Log File
6 Use UDF Server  FALSE
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7.8 Alternative: Standalone VBA module

Sometimes, it might be useful to run xlwings code without having to install an add-in first. To do so, you need
to use the standalone option when creating a new project: xlwings quickstart myproject
——standalone.

This will add the content of the add-in as a single VBA module so you don’t need to set a reference to
the add-in anymore. It will also include Dictionary.cls as this is required on macOS. It will still
read in the settings from your x1lwings.conf if you don’t override them by using a sheet with the name
xlwings.conf.
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CHAPTER 8

RunPython

8.1 xlwings add-in

To get access to Run main (new in v0.16) button or the RunPython VBA function, you’ll need the
xlwings addin (or VBA module), see Add-in & Settings.

For new projects, the easiest way to get started is by using the command line client with the quickstart
command, see Command Line Client (CLI) for details:

$ xlwings quickstart myproject

8.2 Call Python with “RunPython”

In the VBA Editor (A1t-F11), write the code below into a VBA module. xlwings quickstart
automatically adds a new module with a sample call. If you rather want to start from scratch, you can add a
new module via Insert > Module.

Sub HelloWorld()
RunPython "import hello; hello.world()"
End Sub

This calls the following code in hello.py:

# hello.py
import numpy as np
import xlwings as xw

def world():

(continues on next page)
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(continued from previous page)

wb = xw.Book.caller ()
wb.sheets[0] .range ('Al") .value = 'Hello World!'

You can then attach HelloWor1d to a button or run it directly in the VBA Editor by hitting F'5.

Note: Place xw.Book.caller () within the function that is being called from Excel and not outside as
global variable. Otherwise it prevents Excel from shutting down properly upon exiting and leaves you with
a zombie process when you use Use UDF Server = True.

8.3 Function Arguments and Return Values

While it’s technically possible to include arguments in the function call within RunPython, it’s not very
convenient. Also, RunPython does not allow you to return values. To overcome these issues, use UDFs,
see User Defined Functions (UDFs) - however, this is currently limited to Windows only.
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CHAPTER 9

User Defined Functions (UDFs)

This tutorial gets you quickly started on how to write User Defined Functions.

Note:

UDFs are currently only available on Windows.

For details of how to control the behaviour of the arguments and return values, have a look at Con-
verters and Options.

For a comprehensive overview of the available decorators and their options, check out the correspond-
ing APl docs: UDF decorators.

9.1

1)

2)

9.2

One-time Excel preparations

Enable Trust access to the VBA project object model under File >
Options > Trust Center > Trust Center Settings > Macro Settings.

You only need to do this once. Also, this is only required for importing the functions, i.e. end users
won’t need to bother about this.

Install the add-in via command prompt: xlwings addin install (see Add-in & Settings).

Workbook preparation

The easiest way to start a new project is to run x1lwings quickstart myproject on a command
prompt (see Command Line Client (CLI)). This automatically adds the xlwings reference to the generated
workbook.
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9.3 A simple UDF

The default addin settings expect a Python source file in the way it is created by quickstart:
* in the same directory as the Excel file
* with the same name as the Excel file, but with a . py ending instead of . x1sm.
Alternatively, you can point to a specific module via UDF Modules in the xlwings ribbon.

Let’s assume you have a Workbook myproject.x1lsm, then you would write the following code in
myproject.py:

import xlwings as xw

@xw. func

def double_sum(x, Vy):
"""Returns twice the sum of the two arguments"""
return 2 x (x + y)

* Now click on Import Python UDFs in the xlwings tab to pick up the changes made to
myproject.py.

* Enter the formula =double_sum (1, 2) into a cell and you will see the correct result:

Al - f= | =double_sum(1, 2) v
A B C D E F €] H | J

* The docstring (in triple-quotes) will be shown as function description in Excel.

Note:
* You only need to re-import your functions if you change the function arguments or the function name.

* Code changes in the actual functions are picked up automatically (i.e. at the next calculation of the
formula, e.g. triggered by Ctr1-A1t-F9), but changes in imported modules are not. This is the
very behaviour of how Python imports work. If you want to make sure everything is in a fresh state,
click Restart UDF Server.

* The @xw. func decorator is only used by xlwings when the function is being imported into Excel. It
tells xIwings for which functions it should create a VBA wrapper function, otherwise it has no effect
on how the functions behave in Python.
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9.4 Array formulas: Get efficient

Calling one big array formula in Excel is much more efficient than calling many single-cell formulas, so it’s
generally a good idea to use them, especially if you hit performance problems.

You can pass an Excel Range as a function argument, as opposed to a single cell and it will show up in
Python as list of lists.

For example, you can write the following function to add 1 to every cell in a Range:

@xw. func
def add_one (data) :
return [[cell + 1 for cell in row] for row in data]

To use this formula in Excel,
* Click on Import Python UDFs again
* Fill in the values in the range A1 : B2
* Select the range D1 : E2
* Type in the formula =add_one (A1 :B2)

* Press Ctrl+Shift+Enter to create an array formula. If you did everything correctly, you’ll see
the formula surrounded by curly braces as in this screenshot:

D1 - Jx |{=add_one(A1:B2)} v
A B C D | E F G H I T~
1 1 2 2 3
2 3 4 4 5
3

9.4.1 Number of array dimensions: ndim

The above formula has the issue that it expects a “two dimensional” input, e.g. a nested list of the form [ [1,
21, [3, 411. Therefore, if you would apply the formula to a single cell, you would get the following
error: TypeError: 'float' object is not iterable.

To force Excel to always give you a two-dimensional array, no matter whether the argument is a single cell,
a column/row or a two-dimensional Range, you can extend the above formula like this:

@xw. func
@xw.arg('data', ndim=2)
def add_one (data):
return [[cell + 1 for cell in row] for row in data]

9.4. Array formulas: Get efficient 33




xlwings - Make Excel Fly!, Release dev

9.5 Array formulas with NumPy and Pandas

Often, you’ll want to use NumPy arrays or Pandas DataFrames in your UDF, as this unlocks the full power
of Python’s ecosystem for scientific computing.

To define a formula for matrix multiplication using numpy arrays, you would define the following function:

import xlwings as xw
import numpy as np

@xw. func
@xw.arg('x', np.array, ndim=2)
@xw.arg('y', np.array, ndim=2)
def matrix_mult (x, vy):

return x Q@ y

Note: If you are not on Python >= 3.5 with NumPy >=1.10, use x . dot (y) instead of x @ vy.

A great example of how you can put Pandas at work is the creation of an array-based CORREL formula.
Excel’s version of CORREL only works on 2 datasets and is cumbersome to use if you want to quickly
get the correlation matrix of a few time-series, for example. Pandas makes the creation of an array-based
CORREL?2 formula basically a one-liner:

import xlwings as xw
import pandas as pd

@xw. func

@xw.arg('x', pd.DataFrame, index=False, header=False)

@xw.ret (index=False, header=False)

def CORREL2 (x) :
"""I,ike CORREL, but as array formula for more than 2 data sets"""
return x.corr ()

9.6 @xw.arg and @xw.ret decorators

These decorators are to UDFs what the opt ions method is to Range objects: they allow you to apply
converters and their options to function arguments (@xw.arqg) and to the return value (@xw.ret). For
example, to convert the argument x into a pandas DataFrame and suppress the index when returning it, you
would do the following:

@xw. func

@xw.arg('x', pd.DataFrame)

@xw.ret (index=False)

def myfunction (x) :
# x 1s a DataFrame, do something with it
return x

For further details see the Converters and Options documentation.
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9.7 Dynamic Array Formulas

Note: If your version of Excel supports the new native dynamic arrays, then you don’t have to do anything
special, and you shouldn’t use the expand decorator! To check if your version of Excel supports it, see if
you have the =UNIQUE () formula available. Native dynamic arrays were introduced in Office 365 Insider
Fast at the end of September 2018.

As seen above, to use Excel’s array formulas, you need to specify their dimensions up front by selecting the
result array first, then entering the formula and finally hitting Ct r1-Shift-Enter. In practice, it often
turns out to be a cumbersome process, especially when working with dynamic arrays such as time series
data. Since v0.10, xlwings offers dynamic UDF expansion:

This is a simple example that demonstrates the syntax and effect of UDF expansion:

import numpy as np

@xw. func
@xw.ret (expand='table")
def dynamic_array(r, c):
return np.random.randn (int (r), int(c))

File Home  Insert  Page Layout Formulas Data  Review

B4 B fx =dynamic_array(B2,C2)
A B C | D | E

il rows: columns:
D 5 2
8
4 2.01156647| -0.0985618
5 | -0.2152179 -0.7541961
6 | 0.37168657 -0.1978662
A -1.0643897 1.37592295
8 0.5272535 -0.0508628
2

Note:

* Expanding array formulas will overwrite cells without prompting
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File Home Insert Page Layout = Formulas Data  Review View  xlwings !

B4 = fx =dynamic_array(B2,C2)
A B C D E F

‘a2 rows: columns:
2 | 2 5
3
£ -0.6788379| -1.0009999 -0.6342434 -0.9362773 1.02582914
A -2.1803953 0.18511092 0.3121721 0.20600051 0.3799863
6

* Pre v0.15.0 doesn’t allow to have volatile functions as arguments, e.g. you cannot use functions like
=TODAY () as arguments. Starting with v0.15.0, you can use volatile functions as input, but the UDF
will be called more than 1x.

* Dynamic Arrays have been refactored with v0.15.0 to be proper legacy arrays: To edit a dynamic
array with xlwings >= v0.15.0, you need to hit Ct r1-Shift-Enter while in the top left cell. Note
that you don’t have to do that when you enter the formula for the first time.

9.8 Docstrings

The following sample shows how to include docstrings both for the function and for the arguments x and y
that then show up in the function wizard in Excel:

import xlwings as xw

@xw. func

@xw.arg('x', doc='This is x.")

@xw.arg('y', doc='This is vy.")

def double_sum(x, Vy):
"""Returns twice the sum of the two arguments"""
return 2 x (x + y)

9.9 The “caller” argument

You often need to know which cell called the UDF. For this, xlwings offers the reserved argument caller
which returns the calling cell as xlwings range object:

@xw. func
def get_caller_address(caller):
# caller will not be exposed in Excel, so use it like so:

(continues on next page)
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(continued from previous page)

# =get_caller_address ()
return caller.address

Note that caller will not be exposed in Excel but will be provided by xlwings behind the scenes.

9.10 The “vba” keyword

By using the vba keyword, you can get access to any Excel VBA object in the form of a pywin32 object.
For example, if you wanted to pass the sheet object in the form of its CodeName, you can do it as follows:

@xw. func

@xw.arg('sheetl', vba='Sheetl")

def get_name (sheetl) :
# call this function in Excel with:
# =get_name ()
return sheetl.Name

Note that vlba arguments are not exposed in the UDF but automatically provided by xIwings.

9.11 Macros

On Windows, as an alternative to calling macros via RunPython, you can also use the @xw . sub decorator:

import xlwings as xw

@xw.sub

def my_macro() :
"""writes the name of the Workbook into Range ("A1") of Sheet 1"""
wb = xw.Book.caller ()
wb.sheets[0].range('Al'") .value = wb.name

After clicking on Import Python UDFs, you can then use this macro by executing it via A1t + F8
or by binding it e.g. to a button. To do the latter, make sure you have the Developer tab selected under
File > Options > Customize Ribbon. Then, under the Developer tab, you can insert a button
via Insert > Form Controls. After drawing the button, you will be prompted to assign a macro to
it and you can select my_macro.

9.12 Call UDFs from VBA

Imported functions can also be used from VBA. For example, for a function returning a 2d array:

Sub MySub ()

Dim arr () As Variant

(continues on next page)
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(continued from previous page)

Dim i As Long, j As Long
arr = my_imported_function(...)

For j = LBound(arr, 2) To UBound(arr, 2)
For i = LBound(arr, 1) To UBound(arr, 1)
Debug.Print "(" &¢ 1 & "," & j & ")", arr(i, 7J)
Next i
Next j

End Sub

9.13 Asynchronous UDFs

Note: This is an experimental feature

New in version v0.14.0.

xlwings offers an easy way to write asynchronous functions in Excel. Asynchronous functions return im-
mediately with #N/A waiting. ... While the function is waiting for its return value, you can use Excel
to do other stuff and whenever the return value is available, the cell value will be updated.

The only available mode is currently async_mode="'threading', meaning that it’s useful for I/O-
bound tasks, for example when you fetch data from an API over the web.

You make a function asynchronous simply by giving it the respective argument in the function decorator. In
this example, the time consuming I/O-bound task is simulated by using t ime . sleep:

import xlwings as xw
import time

@xw. func (async_mode="'threading')

def myfunction(a):
time.sleep (5) # long running tasks
return a

You can use this function like any other xlwings function, simply by putting =myfunction ("abcd")
into a cell (after you have imported the function, of course).

Note that xIwings doesn’t use the native asynchronous functions that were introduced with Excel 2010, so
xlwings asynchronous functions are supported with any version of Excel.
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cHAPTER 10

Matplotlib & Plotly Charts

10.1 Matplotlib

Using pictures.add (), itis easy to paste a Matplotlib plot as picture in Excel.

10.1.1 Getting started

The easiest sample boils down to:

import matplotlib.pyplot as plt
import xlwings as xw

fig = plt.figure()
plt.plot ([1, 2, 3])

sheet = xw.Book () .sheets[0]
sheet .pictures.add(fig, name='MyPlot', update=True)

Note: If you set update=True, you can resize and position the plot on Excel: subsequent calls to
pictures.add () withthe same name ('MyPlot ') will update the picture without changing its position
or size.

10.1.2 Full integration with Excel

Calling the above code with RunPython and binding it e.g. to a button is straightforward and works cross-
platform.
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However, on Windows you can make things feel even more integrated by setting up a UDF along the
following lines:

@xw. func
def myplot (n, caller):
fig = plt.figure ()
plt.plot (range (int (n)))
caller.sheet.pictures.add(fig, name='MyPlot', update=True)
return 'Plotted with n={}'.format (n)

If you import this function and call it from cell B2, then the plot gets automatically updated when cell B1
changes:

10.1.3 Properties

Size, position and other properties can either be set as arguments within pictures.add (), or by manip-
ulating the picture object that is returned, see xIwings.Picture ().

For example:

>>> sht = xw.Book () .sheets[0]
>>> sht.pictures.add(fig, name='MyPlot', update=True,
left=sht.range('B5') .left, top=sht.range('B5').top)

or:
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>>> plot = sht.pictures.add(fig, name='MyPlot', update=True)
>>> plot.height /= 2
>>> plot.width /= 2

10.1.4 Getting a Matplotlib figure

Here are a few examples of how you get a matplotlib £ igure object:

* via PyPlot interface:

import matplotlib.pyplot as plt
fig = plt.figure()
plt.plot([1, 2, 3, 4, 51)

or:

import matplotlib.pyplot as plt
plt.plot ([1, 2, 3, 4, 51)
fig = plt.gcf()

* via object oriented interface:

from matplotlib.figure import Figure
fig = Figure(figsize=(8, 6))

ax = fig.add_subplot (111)

ax.plot ([1, 2, 3, 4, 51)

e via Pandas:

import pandas as pd
import numpy as np

df = pd.DataFrame (np.random.rand (10, 4), columns=['a', 'b', 'c', 'd'])
ax df .plot (kind="bar'")
fig = ax.get_figure()

10.2 Plotly static charts

10.2.1 Prerequisites

In addition to plotly, you will need kaleido, psutil, and requests. The easiest way to get it is
via pip:

$ pip install kaleido psutil requests

or conda:
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$ conda install -c conda-forge python-kaleido psutil requests

See also: https://plotly.com/python/static-image-export/

10.2.2 How to use

It works the same as with Matplotlib, however, rendering a Plotly chart takes slightly longer. Here is a

sample:

import xlwings as xw
import plotly.express as px

# Plotly chart
df = px.data.iris()
fig = px.scatter (df, x="sepal_width",

# Add it to Excel
wb = xw.Book ()

y="sepal_length", color="species")

wb.sheets[0] .pictures.add (fig, name='IrisScatterPlot', update=True)

10.2. Plotly static charts
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Jupyter Notebooks: Interact with Excel

When you work with Jupyter notebooks, you may use Excel as an interactive data viewer or scratchpad from
where you can load DataFrames. The two convenience functions view and 1oad make this really easy.

Note: The view and 1oad functions should exclusively be used for interactive work. If you write scripts,
use the xlwings API as introduced under Quickstart and Syntax Overview.

11.1 The view function

The view function accepts pretty much any object of interest, whether that’s a number, a string, a nested
list or a NumPy array or a pandas DataFrame. By default, it writes the data into an Excel table in a
new workbook. If you wanted to reuse the same workbook, provide a sheet object, e.g. view (df,
sheet=xw.sheets.active), for further options see view.

Changed in version 0.22.0: Earlier versions were not formatting the output as Excel table

11.2 The load function

To load in a range in an Excel sheet as pandas DataFrame, use the 1oad function. If you only select one
cell, it will auto-expand to cover the whole range. If, however, you select a specific range that is bigger than
one cell, it will load in only the selected cells. If the data in Excel does not have an index or header, set them
to False like this: xw. load (index=False), see also load.

New in version 0.22.0.
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cHAPTER 12

Command Line Client (CLI)

xlwings comes with a command line client. On Windows, type the commands into a Command Prompt or
Anaconda Prompt, on Mac, type them into a Terminal. To get an overview of all commands, simply type

x1wings and hit Enter:

addin

quickstart

runpython

restapi

license

Run "xlwings addin install"™ to install the Excel add-
in (will be copied to the XLSTART folder). Instead of
"install" you can also use "update", "remove" or
"status". Note that this command may take a while. Use
the "—--unprotected" flag to install the add-in without
password protection. You can install your custom add-
in by providing the name or path via the --file flag,
e.g. "xlwings add-in install --file custom.xlam"

(New in 0.6.0, the unprotected flag was added in 0.20.
Run "xlwings quickstart myproject" to create a folder
called "myproject" in the current directory with an
Excel file and a Python file, ready to be used. Use
the "--standalone" flag to embed all VBA code in the
Excel file and make it work without the xlwings add-
in.

macOS only: run "xlwings runpython install" if you
want to enable the RunPython calls without installing
the add-in. This will create the following file:
~/Library/Application
Scripts/com.microsoft.Excel/xlwings.applescript

(new in 0.7.0)

Use "xlwings restapi run" to run the xlwings REST API
via Flask dev server. Accepts "--host" and "--port" as
optional arguments.

xlwings PRO: Use "xlwings license update -k KEY" where
"KEY" is your personal (trial) license key. This will
update ~/.xlwings/xlwings.conf with the LICENSE_KEY

(continues on next page)
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(continued from previous page)

config

code

permission

release

entry. If you have a paid license, you can run
"xlwings license deploy" to create a deploy key. This
is not available for trial keys.

Run "xlwings config create" to create the user config
file (~/.xlwings/xlwings.conf) which is where the
settings from the Ribbon add-in are stored. It will
configure the Python interpreter that you are running
this command with. To reset your configuration, run
this with the "--force" flag which will overwrite your
current configuration.

(New in 0.19.5)

Run "xlwings code embed" to embed all Python modules
of the workbook's dir in your active Excel file. Use
the "--file" flag to only import a single file by
providing its path. Requires xlwings PRO.

(Changed in 0.23.4)

"xlwings permission cwd" prints a JSON string that can
be used to permission the execution of all modules in
the current working directory via GET request.
"xlwings permission book" does the same for code that
is embedded in the active workbook.

(New in 0.23.4)

Run "xlwings release" to configure your active
workbook to work with a one-click installer for easy
deployment. Requires xlwings PRO.

(New in 0.23.4)
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Deployment

13.1 Zip files

New in version 0.15.2.

To make it easier to distribute, you can zip up your Python code into a zip file. If you use UDFs, this will
disable the automatic code reload, so this is a feature meant for distribution, not development. In practice,
this means that when your code is inside a zip file, you’ll have to click on re-import to get any changes.

If you name your zip file like your Excel file (but with . zip extension) and place it in the same folder as
your Excel workbook, xlwings will automatically find it (similar to how it works with a single python file).

If you want to use a different directory, make sure to add it to the PYTHONPATH in your config (Ribbon or
config file):

PYTHONPATH, "C:\path\to\myproject.zip"

13.2 RunFrozenPython

Changed in version 0.15.2.

You can use a freezer like Pylnstaller, cx_Freeze, py2exe etc. to freeze your Python module into an exe-
cutable so that the recipient doesn’t have to install a full Python distribution.

Note:
¢ This does not work with UDFs.

* Currently only available on Windows, but support for Mac should be easy to add.
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* You need at least 0.15.2 to support arguments whereas the syntax changed in 0.15.6

Use it as follows:

Sub MySample ()
RunFrozenPython "C:\path\to\dist\myproject\myproject.exe", "argl arg2"
End Sub
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Troubleshooting

14.1 Issue: dll not found

Solution:

1) xlwings32-<version>.dll and xlwings64—-<version>.d11 are both in the same direc-
tory as your python.exe. If not, something went wrong with your installation. Reinstall it with
pip or conda, see Installation.

2) Check your Interpreter in the add-in or config sheet. If it is empty, then you need to be
able to open a windows command prompt and type python to start an interactive Python session.
If you get the error 'python' is not recognized as an internal or external
command, operable program or batch file., then you have two options: Either add
the path of where your python.exe lives to your Windows path (see https://www.computerhope.
com/issues/ch000549.htm) or set the full path to your interpreter in the add-in or your config sheet,
e.g. C:\Users\MyUser\anaconda\pythonw.exe

14.2 Issue: Couldn’t find the local location of your OneDrive or
SharePoint

Solution:

On either the x1wings.conf sheet or on the x1wings.conf file under your home folder (for location
see User Config: Ribbon/Config File), add the following setting:

"ONEDRIVE_WIN", "C:\path\to\OneDrive"

Note: Don’t use quotes on the x1wings.conf sheet and if you are on macOS, use ONEDRIVE_MAC
instead. You need to use the ONEDRIVE setting, even if you use SharePoint.
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Converters and Options

Introduced with v0.